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Chapter 804 

Kendall’s Tau-b 
Correlation Tests 
(Simulation) 
Introduction 
This procedure analyzes the power and significance level of the Kendall’s Tau Correlation significance test using 
Monte Carlo simulation. This test is used to test whether the Kendall’s Tau b correlation coefficient is non-zero. For 
each scenario that is set up, two simulations are run. One simulation estimates the significance level and the other 
estimates the power. 

Kendall’s Tau b is a popular statistic for describing the strength of the monotonic relationship between two 
variables. It ranges between plus and minus one.  

Technical Details 
Computer simulation allows us to estimate the power and significance level that is actually achieved by a test 
procedure in situations that are not mathematically tractable. Computer simulation was once limited to mainframe 
computers. But, in recent years, as computer speeds have increased, simulation studies can be completed on desktop 
and laptop computers in a reasonable period of time.  

The steps to a simulation study are  

1. Specify the test procedure and the test statistic. This includes the significance level, sample size, and 
underlying data distributions. 

2. Generate a random sample of points (X, Y) from the bivariate distribution specified by the alternative 
hypothesis. Calculate the test statistic from the simulated data and determine if the null hypothesis is 
accepted or rejected. These samples are used to calculate the power of the test. In the case of paired data, the 
individual values are simulated are constructed so that they exhibit the specified amount of correlation. 

3. Generate a second random sample of points (X, Y) from the bivariate distribution specified by the null 
hypothesis. Calculate the test statistic from the simulated data and determine if the null hypothesis is 
accepted or rejected. These samples are used to calculate the significance-level of the test. In the case of 
paired data, the individual values are simulated so that they exhibit the specified amount of correlation. 

4. Repeat steps 2 and 3 several thousand times, tabulating the number of times the simulated data leads to a 
rejection of the null hypothesis. The power is the proportion of simulated samples in step 2 that lead to 
rejection. The significance level is the proportion of simulated samples in step 3 that lead to rejection. 
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Simulating Paired Distributions 
In this routine, paired data may be generated from the bivariate normal distribution or from two specified marginal 
distributions. In the latter case, the simulation should mimic the actual data generation process as closely as possible, 
including the marginal distributions and the correlation between the two variables.  

Obtaining paired samples from arbitrary distributions with a set correlation is difficult because the joint, bivariate 
distribution must be specified and simulated. Rather than specify the bivariate distribution, PASS requires the 
specification of the two marginal distributions and the correlation between them. 

Monte Carlo samples with given marginal distributions and correlation are generated using the method suggested by 
Gentle (1998). The method begins by generating a large population of random numbers from the two distributions. 
Each of these populations is evaluated to determine if their means are within a small relative tolerance (0.0001) of 
the target mean. If the actual mean is not within the tolerance of the target mean, individual members of the 
population are replaced with new random numbers if the new random number moves the mean towards its target. 
Only a few hundred such swaps are required to bring the actual mean to within tolerance of the target mean.  

The next step is to obtain the target correlation. This is accomplished by permuting one of the populations until they 
have the desired correlation.  

The above steps provide a large pool (ten thousand to one million items) of random number pairs that exhibit the 
desired characteristics. This pool is then sampled at random using the uniform distribution to obtain the random 
number pairs used in the simulation.  

This algorithm may be stated as follows. 

1. Draw individual samples of size M from the two distributions where M is a large number over 10,000. 
Adjust these samples so that they have the specified mean and standard deviation. Label these samples A 
and B. Create an index of the values of A and B according to the order in which they are generated. Thus, 
the first value of A and the first value of B are indexed as one, the second values of A and B are indexed as 
two, and so on up to the final set which is indexed as M. 

2. Compute the product-moment correlation between the two generated variates. 

3. If the computed product-moment correlation is within a small tolerance (usually less than 0.001) of the 
specified correlation, go to step 7. 

4. Select two indices (I and J) at random using uniform random numbers.  

5. Determine what will happen to the product-moment correlation if BI  is swapped with BJ . If the swap will 
result in a correlation that is closer to the target value, swap the indices and proceed to step 6. Otherwise, 
go to step 4. 

6. If the computed product-moment correlation is within the desired tolerance of the target correlation, go to 
step 7. Otherwise, go to step 4. 

7. End with a population with the required marginal distributions and correlation.  

A population created by this procedure tends to exhibit more variation in the tails of the distribution than in the 
center. Hence, the results using the bivariate normal option will be slightly different from those obtained when a 
custom model with two normal distributions is used. 

Test Statistic 
This section describes the test statistic that is used.  
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Kendall’s Tau Correlation Coefficient 
Kendall’s Tau correlation coefficient is calculated from a sample of N data pairs (X, Y) by first creating a variable 
U as the ranks of X and a variable V as the ranks of Y (ties replaced with average ranks). Kendall’s Tau is then 
calculated from U and V using 
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The parameter nC is the total number of concordant pairs and nD is the total number of discordant pairs. A pair of 
points (Ui, Yi) and (Uj, Vj) is said to be concordant when either of the following statements is true: 1. (Ui < Uj) 
and (Vi  < Vj); 2. (Ui  > Uj) and (Vi  > Vj). Similarly, a pair of points is said to be discordant when either of the 
following statements is true: 1. (Ui < Uj) and (Vi  > Vj); 2. (Ui  > Uj) and (Vi  < Vj). Pairs in which (Ui  = Uj) or (Vi  
= Vj) are not classified as concordant or discordant and are ignored. 

The value of t(X)i is the number of ties in the ith set of ties of the X variables. There are SX sets of ties in the X 
variable. The value of t(Y)i is the number of ties in the ith set of ties of the Y variables. There are SY sets of ties in 
the Y variable. 

Test Statistic 
The statistical significance of Kendall’s tau is tested using  
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The distribution of z is approximately normal. 

Test Procedure 
The testing procedure is as follows. H0 is the null hypothesis that τ is zero. H1 represents the alternative 
hypothesis that the actual τ is non-zero. Choose a value zα, based on the normal distribution, so that the 
probability of rejecting H0 when H0 is true is equal to a specified value, α.  

Select a sample of N items from the population and compute their test statistic z. If z > zα reject the null 
hypothesis that τ = 0 in favor of an alternative hypothesis that τ > 0. The power is the probability of rejecting H0 
when τ = τ1.  

Unfortunately, the correlation that is entered into PASS is ρ1, not τ1. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Solve For 
This option specifies whether you want to solve for sample size or power.  

Select Sample Size when you want to determine the sample size needed to achieve a given power and alpha error 
level.  

Select Power when you want to calculate the power for a given power.  

Hypothesis and Simulations 

Alternative Hypothesis 
This option specifies the alternative hypothesis. This implicitly specifies the direction of the hypothesis test. The 
null hypothesis is H0: τ = 0. 

Note that the alternative hypothesis enters into power calculations by specifying the rejection region of the 
hypothesis test. Its accuracy is critical. 

Possible selections are: 

• τ ≠ 0 
This is the most common selection. It yields the two-tailed test. Use this option when you are testing whether 
the correlation values are different, but you do not want to specify beforehand which correlation is larger. 

• τ > 0 
This option yields a one-tailed test. 

• τ < 0 
This option also yields a one-tailed test. 
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Simulations 
This option specifies the number of simulations, M. The larger the number of simulations, the longer the running 
time and the more accurate the results. 

The precision of the simulated power estimates are calculated from the binomial distribution. Thus, confidence 
intervals may be constructed for various power values using the binomial distribution. The following table gives 
an estimate of the precision that is achieved for various simulation sizes when the power is either 0.50 or 0.95. 
The table values are interpreted as follows: a 95% confidence interval of the true power is given by the power 
reported by the simulation plus and minus the ‘Precision’ amount given in the table. 
  

 Simulation Precision Precision 
 Size when when 
 M Power = 0.50 Power = 0.95 
 100 0.100   0.044 
 500 0.045   0.019 
 1000 0.032   0.014 
 2000 0.022   0.010  
 5000 0.014   0.006 
 10000 0.010   0.004 
 50000 0.004   0.002 
 100000 0.003   0.001 
   

Notice that a simulation size of 1000 gives a precision of plus or minus 0.01 when the true power is 0.95. Also 
note that as the simulation size is increased beyond 5000, there is only a small amount of additional accuracy 
achieved.  

Power and Alpha (or Alpha) 

Power 
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, 
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null 
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of 
equal correlations when in fact they are different. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 
0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.  

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when you 
reject the null hypothesis of equal correlations when in fact they are equal.  

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means 
that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that 
represents the risk of a type-I error you are willing to take in your experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  

Sample Size 

N (Sample Size) 
The number of observations in the sample. Each observation is made up of two values: one for X and one for Y. 
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Correlations 

ρ1 (Correlation|H1) 
Specify the value of ρ1, the population product-moment correlation under the alternative hypothesis. Note that the 
range of the correlation is between plus and minus one. The difference between ρ0 and ρ1 is being tested by this 
significance test. 

You can enter a range of values separated by blanks or commas. 

Note that this is the value of the Pearson product-moment correlation, not Kendall’s tau correlation. 

Power and Alpha Simulations 

Distribution 
Specify whether a bivariate normal or a custom bivariate distribution is used to generate the data. The possible 
choices are: 

• Bivariate Normal 
Bivariate normal distributions are simulated with zero means, unit variances, and correlations ρ0 and ρ1 to 
create the alpha and power simulations, respectively. 

• Custom 
A bivariate distribution is specified by setting the two marginal distributions and their correlation (ρ0 for the 
alpha simulation and ρ1 for the power simulation). 

The algorithm proceeds by generating a pool of several thousand random pairs from the X and Y 
distributions. To achieve the desired correlation, pairs of points are randomly selected and their X values are 
swapped if the switch results in an overall correlation closer to the desired value. 

When applied to normal data, this algorithm results in a bivariate population that is narrower in the center and 
wider in the tails than the standard bivariate normal. 

Custom Power and Alpha Simulations 
These options specify the distributions of X and Y to be used in the power simulation (on the left) and the alpha 
simulation (on the right). All distributions are specified with the same syntax. 

Distribution 
Specify the distribution of each variable under the alternative hypothesis, H1, on the left and under the null 
hypothesis, H0, on the right.  

For convenience in specifying a range of values, the parameters of a distribution can be specified using numbers 
or letters. If letters are used, their values are specified in the Parameter Values boxes below.  

Following is a list of the distributions that are available and the syntax used to specify them. Each of the 
parameters should be replaced with a number or parameter name. 

 
Distributions with Common Parameters 
Beta(Shape1, Shape2, Min, Max) 

Binomial(P,N) 

Cauchy(Mean,Scale) 

Constant(Value) 

Exponential(Mean) 
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Gamma(Shape,Scale) 

Gumbel(Location,Scale) 

Laplace(Location,Scale) 

Logistic(Location,Scale) 

Lognormal(Mu,Sigma) 

Multinomial(P1,P2,P3,...,Pk) 

Normal(Mean,Sigma) 

Poisson(Mean) 

TukeyGH(Mu,S,G,H) 

Uniform(Min, Max) 

Weibull(Shape,Scale) 

 

Distributions with Mean and SD Parameters 
BetaMS(Mean,SD,Min,Max) 

BinomialMS(Mean,N) 

GammaMS(Mean,SD) 

GumbelMS(Mean,SD) 

LaplaceMS(Mean,SD) 

LogisticMS(Mean,SD) 

LognormalMS(Mean,SD) 

UniformMS(Mean,SD) 

WeibullMS(Mean,SD) 

 

Details of writing mixture distributions, combined distributions, and compound distributions are found in the 
chapter on Data Simulation and will not be repeated here. 

Power and Alpha Simulations – Parameter Values 
for X and Y Distributions 
These options specify the names and values for the parameters used in the distributions.  

Name 
Up to five sets of named parameter values may be used in the simulation distributions. This option lets you select 
an appropriate name for each set of values. Possible names are 

• A to Z 
You might use these letters for location, shape, and scale parameters. 

Value(s) 
These values are substituted for the Parameter Name (M1, M2, SD, A, B, C, etc.) in the simulation distributions. 
If more than one value is entered, a separate calculation is made for each value. 

You can enter a single value such as “2” or a series of values such as “0 2 3” or “0 to 3 by 1”. 
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Simulations Tab  
The options on this tab controls the generation of the random numbers. For complicated distributions, a large pool 
of random numbers from the specified distributions is generated. Each of these pools is evaluated to determine if its 
mean is within a small relative tolerance (0.0001) of the target mean. If the actual mean is not within the tolerance of 
the target mean, individual members of the population are replaced with new random numbers if the new random 
number moves the mean towards its target. Only a few hundred such swaps are required to bring the actual mean to 
within tolerance of the target mean. This population is then sampled with replacement using the uniform distribution. 
We have found that this method works well as long as the size of the pool is at least the maximum of twice the 
number of simulated samples desired and 10,000.  

Random Numbers 

Random Number Pool Size 
This is the size of the pool of values from which the random samples will be drawn. Pools should be at least the 
minimum of 10,000 and twice the number of simulations. You can enter Automatic and an appropriate value will 
be calculated. 

If you do not want to draw numbers from a pool, enter 0 here. 

Correlation 

Maximum Switches 
This option specifies the maximum number of index switches that can be made while searching for a permutation 
of Y that yields a correlation within the specified tolerance. 

A value near 5000000 is needed when the correlation is large. 

Correlation Tolerance 
Specify the amount above and below the target correlation that will still let a particular index-permutation to be 
selected as the bivariate population. 

For example, if you have selected a correlation of 0.3 and you set this tolerance to 0.001, then permutations will 
continue until one is found which yields a correlation between 0.299 and 0.301. 

Recommended: 0.001 

Valid Values: 0 to 0.99. 
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Example 1 – Finding the Power 
Suppose a study will be run to test whether Kendall’s tau between forced vital capacity (X) and forced expiratory 
value (Y) in a particular population is non-zero. Find the power if ρ1 = 0.20 and 0.30, alpha is 0.05, and N = 20, 
60, 100.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Kendall’s Tau-b Correlation Tests (Simulation) procedure window by expanding 
Correlation, then Correlation, then clicking on Test (Inequality), and then clicking on Kendall’s Tau-b 
Correlation Tests (Simulation). You may then make the appropriate entries as listed below, or open Example 1 
by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Alternative Hypothesis ............................ τ ≠ 0 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 20 60 100 
ρ1 (Correlation|H0) ................................. 0.2 0.3 
Distribution .............................................. Bivariate Normal 

Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Simulation Summary 
 
 Power (H1) Alpha (H0) 
 Simulation Simulation 
Variables Distribution Distribution 
X and Y Bivariate Normal Bivariate Normal 
 
Random Number Pool Size 10000 
Number of Simulations 5000 
 
 
Numeric Results for Testing Correlation Hypotheses: H0: τ = 0; H1: τ ≠ 0 
 
    Sample         H0   H1               
      Size       Corr Corr Target Actual 
Row      N Power   ρ0   ρ1  Alpha Alpha       
1 20 0.107 0.000 0.200 0.050 0.051        
2 60 0.290 0.000 0.200 0.050 0.051        
3 100 0.502 0.000 0.200 0.050 0.047        
4 20 0.208 0.000 0.300 0.050 0.047        
5 60 0.609 0.000 0.300 0.050 0.045        
6 100 0.824 0.000 0.300 0.050 0.046        
 
Run Time: 5.29 seconds. 
 
 
References 
Kendall, M. and Gibbons, J.D. 1990. Rank Correlation Methods, 5th Edition. Oxford University Press. New York. 
 Devroye, Luc. 1986. Non-Uniform Random Variate Generation. Springer-Verlag. New York. 
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Report Definitions 
N is the size of the sample drawn from the population. It is the number of X-Y data points in a sample. 
Power is the probability of rejecting a false null hypothesis. It is calculated by the power simulation. 
ρ0 is the Pearson correlation coefficient assuming the null hypothesis, H0. This is the value being tested. 
ρ1 is the Pearson correlation coefficient assuming the alternative hypothesis, H1. This is the value at which 
   the power is computed. 
Target Alpha is the probability of rejecting a true null hypothesis. It is set by the user. 
Actual Alpha is the alpha level that was actually achieved by the experiment. It is calculated by the alpha 
   simulation. 
Beta is the probability of accepting a false null hypothesis. 
 
Summary Statements 
A sample size of 20 achieves 11% power to detect a Pearson correlation of 0.200 using a two-sided 
hypothesis test with a significance level of 0.050. These results are based on 5000 Monte Carlo 
samples from the bivariate normal distribution under the alternative hypothesis. 
 
 
Power and Alpha Confidence Intervals from Simulations 
 
                   Lower   Upper                 Lower   Upper 
                   Limit   Limit                 Limit   Limit 
    Sample        of 95%  of 95%                of 95%  of 95% 
      Size        C.I. of C.I. of Target Actual C.I. of C.I. of 
Row       N  Power   Power   Power  Alpha  Alpha   Alpha   Alpha       
1 20 0.107 0.098 0.115 0.050 0.051 0.045 0.057       
2 60 0.290 0.277 0.303 0.050 0.051 0.045 0.057       
3 100 0.502 0.488 0.516 0.050 0.047 0.041 0.053       
4 20 0.208 0.197 0.219 0.050 0.047 0.041 0.052       
5 60 0.609 0.596 0.623 0.050 0.045 0.040 0.051       
6 100 0.824 0.813 0.834 0.050 0.046 0.040 0.052       
 
Definitions of the Power and Alpha Confidence Intervals Report 
N is the size of the sample drawn from the population. It is the number of X-Y data points in a sample. 
Power is the probability of rejecting H0 when it is false. This is the actual value calculated by the power 
   simulation. 
Lower and Upper Limits of a 95% C.I. for Power are the limits of an exact, 95% confidence interval for power 
   based on the binomial distribution. They are calculated from the power simulation. 
Target Alpha is the desired probability of rejecting a true null hypothesis at which the tests were run. 
Actual Alpha is the alpha achieved by the test as calculated by the alpha simulation. 
Lower and Upper Limits of a 95% C.I. for Alpha are the limits of an exact, 95% confidence interval for alpha 
   based on the binomial distribution. They are calculated from the alpha simulation 
 

The Numeric Results report gives the basic results. The Power and Alpha Confidence Intervals report provides a 
confidence interval for each power and alpha value that was simulated. Definitions follow the reports. 
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Plots Section 
 

  
   

     
 

These plots show the relationship between power and sample size in this example.  
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Example 2 – Validation using Zar 
Zar (1984) page 312 presents an example in which the power of a Pearson’s correlation coefficient is calculated. 
If N = 12, alpha = 0.05, ρ0 = 0, and ρ1 = 0.866, Zar calculates a power of 98% for a two-sided test. We know that 
the power of Spearman’s rho should be similar to that of Pearson’s correlation. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Kendall’s Tau-b Correlation Tests (Simulation) procedure window by expanding 
Correlation, then Correlation, then clicking on Test (Inequality), and then clicking on Kendall’s Tau-b 
Correlation Tests (Simulation). You may then make the appropriate entries as listed below, or open Example 2 
by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Alternative Hypothesis ............................ τ ≠ 0 
Simulations ............................................. 50000 
Alpha ....................................................... 0.05 
N (Sample Size) ...................................... 12 
ρ0 (Correlation|H0) ................................. 0.0 
ρ1 (Correlation|H0) ................................. 0.866 
Distribution .............................................. Bivariate Normal 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Testing Correlation Hypotheses: H0: τ = 0; H1: τ ≠ 0 
 
    Sample         H0   H1               
      Size       Corr Corr Target Actual 
Row      N Power   ρ0   ρ1  Alpha Alpha       
1 12 0.943 0.000 0.866 0.050 0.046        
 

The power of 0.94 is a little less than Zar’s result, as we would expect. 
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